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VBOXTools – REPORT GENERATOR

概要
Report Generator 機能は、テキストベースのデータを素早く正確に作成し提供することを目的としています。

“ 列のタイトル” と” テスト条件” を設定した後、ファイルをスキャンすろことで、ロードしたファイル内の条件を満たした

結果を抽出することができます。プリセットされたテスト設定ボタンが 5 つあり、これを利用することでファイルからデータ

を素早く抽出できます。

Report Generator は、結果の表だけでなく、抽出した箇所のグラフを表示することもできます。

例えば、複数回のブレーキテスト（ブレーキトリガーを使用）がコンパクトフラッシュカードに記録されている場合には、フ

ァイルをロードし、[トリガーテスト] テスト設定アイコンをクリックし、次に [Scan File (F2)] を押します。これでファイル内の

ブレーキトリガー停止距離の結果がすべて表示されます。

ユーザー独自のテスト設定の作成できます。プリセットされたテスト設定ファイルを修正し、名前を変更してセーブして、

後で利用することもできます。

Report Generator 機能はファイルのリプレイにも利用でき、グラフウィンドウおよびライブウィンドウに結果を再生できま

す。

Report Generator のタイトルバーは、ユーザーが作成したテスト設定や、使用中のテスト設定ファイルの名前などを表

示します。

上記は [Report Generator] 画面の例であり、上部にツールバーが表示されています。画面の内容はサーキットテストの

結果であり、トラック上に設定した通過地点でのデータが表示されています。

Report Generator 機能を初めて実行すると、大きなエクセル型のウィンドウが表示され、その中身は空白です。[Report 

Generator] 画面に結果を表示するには、スキャンするデータをロードし、列のタイトルを設定し、「テスト条件」を設定して、

スキャンする必要があります。
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Report Generator の基本操作

Load
メニューバーで [File] → [Load] をクリックし、ファイルを VBOXTools ソフトウェアにロードします。これにより[Report 

Generator] 画面での分析やグラフ画面での表示が可能になります。

[Report Generator] → [Load into RepGen] アイコンをクリックすると、ファ

イルは [Report Generator] 画面にロードされますが、グラフ画面には変

化はありません。

“Load into RepGen” 機能は、多数のファイルをロードし、ファイルの一部分を同じグラフ上で比較したい場合に便利です。

結果を印刷＆セーブする

印刷する
Report Generator ソフトウェアの現在の結果をプリンタで印刷するには、[Report Generator] ツールバーの [Print 

Results] ボタンをクリックします。

セーブする
[Report Generator] ウィンドウの現在の結果は、5 つの出力フォーマットのいずれ

かでセーブできます。フォーマット選択ウィンドウを開くには、[Report Generator] 

ツールバーの [Save Results] アイコンをクリックします。5 つのフォーマットから 1 

つ選択すると、[Windows Save] ダイアログボックスが現れます。

コピー＆ペースト
[Save] ボタンでセーブする方法の他に、データをメインレポート画面から直

接コピー＆ペーストして、他のアプリケーション、例えば Microsoft Word や

Excel にコピーすることもできます。

データをコピー＆ペーストするには、マウスポインタを必要な情報の左上端

のセルに移動します。続いて左マウスボタンをクリックして押したまま、マウ

スポインタを必要なデータの右下端へドラッグします。左ボタンを離した後、

[CTRL] + [C] キーを押す、または右マウスボタンをクリックして [Copy] を選

択し、データをコピーします。

データをペーストするには、例えば Excel 等の新しいアプリケーションを開き

ます。次に右クリックして [ 貼り付け] を選択します。

  

Pick Test
[Pick Test] オプションを使うと、以前にセーブした RepGen テストを

素早く簡単に選択し、VBOXTools ソフトウェアにロードできます。

[Report Generator] → [Pick Test] をクリックし、セーブされたテスト

が表示される ディレクトリを確認します。目的のテストを選択し、

[Load] ボタンをクリックします。

Test Setup
このオプションを選択すると、Report Generator のテスト条件の設定が可能になります。
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Start/Scan File
[オフライン]

[Start/Scan File] アイコンをクリック、または [F2] ボタンを押すと、Report Generator ソフトウェアがロードしたファイルを

スキャンし、ロードされたテスト条件に適合する結果を抽出して表示します。

ファイルのスキャン中、 列の見出しが緑色で強調表示され、スキャンが進行中であることを知らせます。選択した開始お

よび終了条件に従ってテストの抽出が可能になると、青色の強調表示に変わります。

[オンライン]

Report Generator はオンラインでも利用することができます。[Start/Scan File] アイコンをクリック、または [F2] ボタンを

押すと、シリアルデータの処理が開始されます。車両が走行を開始して、設定されたテスト条件を満たすと結果が表示さ

れます。

Report Generator がシリアルデータをスキャン中、カラムの見出しが緑色で強調表示されます。テスト開始条件が満た

され、結果が表示されると、強調表示は青色に変わります。

Pause
[Pause]アイコンをクリックすると、ロードしたファイル内の現在のカーソル位置で Report Generator が一時停止します。

スキャンを一時停止した場合、[Scan File] ボタンまたは [Pause] ボタンを再度押すと、現在の位置からスキャンが再開

され、[Reset] ボタンを押すと画面上の結果は削除され、ファイルの先頭に戻ります。

Stop
Report Generator をリアルタイムで使用している場合、[Stop] アイコンをクリックすると、VBOX からのライブデータのス

キャンが停止します。

Reset
[Reset] アイコンをクリックすると、画面から現在の結果がすべてクリアされます。この機能が実行中、カラムの見出しは

赤色になります。

File Replay
[File replay] オプションにより、ファイルを 5 種類の速度でスキャンできま

す。これは、リプレイするファイルのチャンネルをライブウィンドウで表示

する際にも便利です。

リプレイメニューにアクセスするには、[Report Generator] メニューをクリ

ックし、[Replay Speed] を選択します。リプレイ速度は、クイックスキャン、

1 倍、2 倍、5 倍、またはコンピュータが達成できる最高速度です。

リプレイ中、マップウィンドウのカーソルが時間毎の車両の位置を追跡します。 グラフ画面では、カーソルはファイルの

現在位置を追跡します。

左下のスクリーンショットは、ランの開始時点で、車両の位置（青色と 赤色の カーソルで表示）に殆ど差が無いことを表

しています。しかし、右下のスクリーンショットは、ラップの終盤で車両の位置が大きく異なることを表しています。赤色で

表示するランの方が速くなっています。
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注：多数のライブウィンドウが開いている場合、ライブデータウィンドウの描画に時間がかかり、リプレイ速度が選択した

速度に達しないことがあります。特に、処理速度の遅いコンピュータの場合は注意が必要です。

Multi-Part Test / Batch Test
[Batch Test] オプションでは、様々なテストを連続して実施できます。これは 1 回の実車計測で様々なテストを行う場合

や、装置の校正計測を行いその校正結果を Report Generator の結果に書き込む場合に役立ちます。

Batch Test はリアルタイムでも後処理でも実行できます。
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プリセットテスト設定ボタンの使い方
[Report Generator] 画面にはあらかじめ登録された 5 つのプリセットテスト設定があり、[Report Generator] ツールバー

のボタンでアクセスできます。

この既存のテスト設定を修正することもでき、変更するとメインインストールディレクトリの [Saved Tests] ディレクトリ に

保存されます。これらのテスト設定はテストの内容ごとに作成します。作成されたテスト設定は、後で修正したり、削除を

することもできます。もし、間違ったテスト設定のファイルを作成してしまったら、そのテスト設定ファイルを削除することで、

次回、プリセットテスト設定ボタンを押した際にデフォルトファイルが再作成されます。同様に後で修正し、必要に応じて

名前を変更できます。

Brake Test
このテスト設定では、列のタイトルは自動的

に右のように設定されます。

開始条件は 100km/h、終了条件は 0km/h です。

Trigger Test
このテスト設定では、列のタイトルは自

動的に右のように設定されます。

開始条件はブレーキトリガーON 、終了条件は 0km/h に設定されます。なお、各ブレーキ停止の最終結果のみを表示し、

多数のテストの結果を同じ画面に表示できるように設定されています。

Circuit Test
このテスト設定では、列のタイトルは自動的に

右のように設定されます。

開始条件はスタート／フィニッシュライン通過、終了条件もスタート／フィニッシュライン通過に設定され、ラップタイムが

表示されます。

注：スタート／フィニッシュラインデータが保存されているスプリットファイル (.spl) もロードする必要があります。

Accel Test

このテスト設定では、列のタイトルは自動的に右のよう

に設定されます。

このテストセットアップでは、 開始条件は 0km/h、終了条件は [加速終了時]に設定されます。

また、10km/h ごとのデータ行が作成されます。

0 - 0 (Zero to Zero)Test
このテスト設定では、列のタイトルは自動

的に右のように設定されます。

開始条件は 0km/h、終了条件は 0km/h に設定されます。これにより、結果はゼロで始まりゼロで終わる測定結果が表

示されます。
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Report Generator を使った後処理
ここでは、VBOX ファイルからデータを抽出し、その結果を表に表示した後、選択したランをグラフ画面で比較する手順

を説明します。ここで取り上げる例では、ファイルには多数の加速テスト走行が保存されているものを使用しますが、他

のタイプのテストでも操作方法は同じです。

ステップ 1：ファイルをロードする
メインボタンバーの [Report Generator] ボタンをクリックして[Report 

Generator] 画面を開き、ファイルメニューから、または  [Report 

Generator] → [Load Into RepGen] オプションを選択し、ファイルをロード

します。

ステップ 2：テスト設定を作成する
列のタイトルを指定し、テスト設定を作成してください。詳細は本章の「カスタムテスト設定の作成」を参照してください。も

しくは、表示したいテストに最適なプリセットテスト設定を（ [Report Generator] ツールバーから）1 つ選択します。この例

では、プリセットテスト設定 [Accel Test] を選択しています。

ステップ 3：ファイルをスキャンする
上記の手順でテスト設定の作成とファイルのロードは終了し

ました。次に [Scan File] アイコンをクリックすると、ソフトウェ

アがテスト条件と合致するすべてのランのファイルを処理しま

す。このスキャンの結果は直ちに [Report Generator] 表に表

示されます。

右の画面は、加速テストのスキャンの結果です。この例では

有効なランが 3 つ検出され、10km/h ごとのデータが表に示

されています。このレポートは、VBOXTools ソフトウェア CD 

に含まれている サンプルファイル、”accel_example. vbo” か

ら作成されています。ユーザーテキストの列を挿入し、テスト

に関するコメントを追加できます。そのコメントは結果と共にセ

ーブできます。

ランの強調表示
ファイルスキャン中にグラフ画面が開いていた場合、各ランの

箇所をグラフ上に表示できます。表示したいランの最後の行

をクリックするだけで、グラフに緑色で強調表示されます。な

お、アイコンまたはチェックボックスを含むセルをクリックして

も、強調表示は機能しません。

ステップ 4：グラフ画面にランを表示する
ランの 1 つをグラフ画面に表示するには、[Graph run] 列の各ランの最後にある [Graph] アイコンをク

リックします。グラフ画面が表示され、このランのデータがグラフ画面のグラフ、データ、およびマップ

ウィンドウに表示されます。

ステップ 5：グラフ画面でランを比較する
Report Generator の結果から別のランをグラフ画面で比較するには、比較したいランの [Graph] アイコンをクリックしま

す。選択ボックスが表示されるので、任意の [Compare Run] ボタンを選択すると、ランは比較ファイルとしてロードされま

す。比較するランとオリジナルのランがグラフ画面に表示されます。次ページの例を参照してください。

次ページの例にあるように、メインランは 赤色、比較ランは青色で表示されます。この時点でフルグラフ画面を実行して

いるため、グラフ画面のすべての機能を利用できます。
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ステップ 6：グラフ画面で異なるファイルのランを比較する
異なるファイルのランを比較するには、最初のファイルをロードした後、上

記のステップ 1－5 を行う必要があります。その後、[Rep Gen] ツールバー

の [Load into RepGen] ボタンをクリックして、比較するもう 1 つのファイル

をロードします。これでファイルは Report Generator にロードされます。グラフウィンドウにすでに表示されているファイ

ル情報は上書きされません。

2 番めのファイルをロードした後、Report Generator の [Scan]ボタンを押します。テスト条件

に合致するランが抽出され、Report Generator の表に表示されます。次に、新たに表示され

たランの中で、グラフ画面で比較したいランの [Graph] アイコンをクリックします。[Open as] 

ウィンドウが表示され、そのランと既存のランをグラフ画面で比較できます。

複数のラップをリプレイする
異なるログファイルからの複数のサーキットラップを比較し、ファイルをリプレイして、リプレイ

中に各ランに対応する車両の位置を確認できます。これは、サーキットのどのポイントでドライバー がタイムを上げ、ま

たは下げるのかを視覚で確認するのに便利です。

上記の 1 －6 のステップに従い、複数の 比較ランをグラフ画面にロードします。

それぞれの比較ランに対応するカーソルタイプを選択します。

下の例は、同じサーキットでの 2 つのラップの比較です。赤色のラップは、ラップ全般を通じて多くのポイントで速度が上

回っており、明らかに速いのが分かります。
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Report Generator を使ったライブデータ解析
ここでは、VBOX のライブデータからテストの結果を抽出する方法、その結果を表に表示する方法、そして選択したラン

をグラフ画面で比較する方法を説明します。ここで紹介する例では、ファイルには多数のブレーキトリガーテスト走行が

保存されているものを使用しますが、他のタイプのテストでも操作方法は同じです。

ステップ 1：リアルタイムモードを設定する

このテストのデータは VBOX のシリアル通信を利用しているので、オンラインモードに切り替

える必要があります。[F11] キーを押す、または[Source] アイコンをクリックするとオンライン

モードに切り替わります。

画面のビューに [Disk Logging] ウィンドウがない場合は、メインツールバーの [Tools] アイコンをクリックし、ドロップダウ

ンメニューから [PC File Manager] を選択して、ディスクロギング機能を有効にします。詳細については別マニュアルの

「ディスクロギング」の項を参照してください。

メインボタンバーの [Report Generator] アイコンをクリックし、[Report Generator] 画面を開きます。

ステップ 2：テスト設定を作成する
次に、行うテストのテスト設定を作成します。この例ではブレーキトリガーテストです。この作成を行うには、

[Report Generator] 画面のツールバーのプリセットテスト設定から 1 つを選択、またはカスタムテスト設定ファイ

ルをロードします。このテスト用に新しいテスト設定を作成することもできます。この例では、プリセットテスト設定 [トリガ

ーテスト] を使用しています。

ステップ 3：ライブウィンドウを作成する
[Report Generator] ウィンドウにライブデータ結果が表示されるのに加えて、ライ

ブウィンドウを作成し、テスト中に VBOX から計算されたデータを表示することがで

きます。詳細については別マニュアルの「VBOXTools － データ表示」の項を参照

してください。

例えば、[Report Generator] ウィンドウで MFDD カラムが設定されている場合、

MFDD の結果を表示するライブウィンドウを作成できます。ライブウィンドウに列の

データを表示するには、その列タイトルでマウスを右クリックし、[View as Live 

Data] を選択します。

スタート、スプリット、またはフィニッシュラインで速度が必要な場合は、[Lap Timing] ライブウィンドウを使用してください。

その理由は、このウィンドウはスタート、スプリットまたはフィニッシュラインを通過したときにのみ更新されるためです（標

準の速度ライブウィンドウは、ライブウィンドウの作成方法に応じて、サンプルごとまたは RepGen 結果ラインごとに更新

されます）。[Data Display - Lap Timing] ライブウィンドウの作成は、メインメニューの [New Data Display] アイコンを使い、

[Lap Timing] グループから適切なチャンネルを選択します。

ステップ 4：テストを実施する
Report Generator ソフトウェアで VBOX デー

タのスキャンを開始するには、[Start] アイコ

ンをクリックするか [F2] を押します。ディスク

ロギングがまだ動作していない場合、ディス

クロギングの[Start] アイコンを押すと、こちら

も動作が開始されます。

これで、テストの開始に必要なものはすべて

設定されました。この状態で、ブレーキトリガ

ー試験を行うと、[Report Generator] 画面に

トリガーからゼロまでの結果が示されます。

ライブウィンドウは一定のデータを示し、

Report Generator から作成されるライブウィ

ンドウは適宜更新されます。
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前頁の画面の例では、 [Report Generator] 表にライブブレーキトリガーテストの結果が示されています。ライブデータウ

ィンドウには UTC 時刻、衛星数、速度（線グラフと数値ディスプレイの両方）、およびスムージングされた前後方向加速

度をテキストで示しています。

ステップ 5：グラフ画面にデータを表示する
[Report Generator] ウィンドウが取り込んだランを表示するには、初めに [Stop] アイコンを

クリック、または [F3] キーを押し、Report Generator ソフトウェアによるライブデータのスキャ

ンを停止します。次に、表示するランの [Graph] アイコンをクリックします。選択したランから

のデータをロードしたグラフ画面が開きます。このデータと別のランを [Report Generator] 

ウィンドウで比較する場合、選択したランの [Graph] アイコンをクリックし、 目的の [Compare 

Run X] アイコンを選択して、比較ランとなるファイルをロードします。
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カスタムテスト設定の作成

列のタイトルを設定する
カスタムテスト設定を作成するには、初めにテストで表示されるパラメータの登録を

行います。 テスト設定ファイルがすでにロードされている場合、グレーの列タイトル

ボックスの目的の位置にカーソルを置き、マウスで右クリックして不要な列を削除し

ます。右クリックをすると、[Insert Column]、[Delete Column]、[Clear Column]、およ

び [Clear all Columns] オプションが表示されます。

この後、テストに必要なチャンネルを、列タイトルボックスに追加します。まず、空白

の列タイトルボックスをクリックします。すると、ドロップダウンメニューを含んだウィン

ドウが表示され、 その列のデータが表示されます。初期設定では “Blank（空白）”

になっています。

“Blank” の右にある矢印をクリックし、利用できるパラメータのリストを表示します。

このリストには、VBOX データファイルに保存されているログされたパラメータ、およ

び距離などの計算値がすべて表示されます。ADC03 アナログモジュールや TC8 

熱電対モジュールなどの外部チャンネルが VBOX データファイルにログされている

場合、それらのチャンネルもリストに表示されます。演算チャンネル機能を使って設

定された演算チャンネルもリストに表示されます。

ドロップダウンメニューでデータチャンネルを選択すると、データチャンネルに適用可

能な属性リストが表示されます。Column label は編集可能です。乗数(Multiplier)や

オフセット(Offset)も適用できます。

Average From Start
ランの開始条件から終了条件までのファイル内のサンプル値すべての平均が計算

されます。

Average Between Test Lines
現在表示されているデータ行と 1 つ前のデータ行の間のすべてのサンプル値の平

均を出します。

Minimum
各ランに対して、このチャンネルの最小値を表示します。

Maximum
各ランに対して、このチャンネルの最大値 を表示します。

Minimum between test lines
表示データ行と 1 つ前の表示データ行との間のチャンネルの最小値を表示します。

Maximum between test lines
表示データ行と 1 つ前の表示データ行との間のチャンネルの最大値を表示します。

Delta Between Test Lines
各テストラインの値の差を表示します。

Show Column Average
すべてのランデータの平均が計算され、その結果の値がこの列の最後に表示されます。

例えば、多数のランが保存されたファイルから平均ブレーキ停止距離を素早く表示する際に利用できます。

Click 
Here
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Standard Deviation
すべてのランデータの結果に対する標準偏差が計算され、その結果がこのカラムの最後に表示されます。このデータに

よりすべての結果の一貫性を確認できるため、非常に便利です。

標準偏差は以下の方法で計算されます。

1）すべての値の平均を計算します。

サンプル 1 からサンプル N までの値をすべて合計し、

1/ サンプル数を掛けます。

2）次に、各ポイントと平均値の差の 2 乗を合計し、

1/ サンプル数を掛け、平方根を求めます。

利用可能なパラメータ

列タイトルとして選択可能なパラメータのリストには、 標準の VBOX チャンネルおよび利用可能な CAN チャンネルのみ

ならず、便利な チャンネルが多数含まれています。

 Run number（ラン番号） – この番号は新しいランごとに増加します（テスト 開始条件から終了条件の間のデータ

ごとに番号が付けられます。）。

 MFDD – 平均飽和減速度を意味し、通常、テスト開始速度の 80% から 10% の速度で得られる、ブレーキテスト

の平均減速度です。

 Corrected distance（補正距離）– ブレーキトリガーON 付近からテスト終了速度までの距離です。指定された

「補正距離の開始速度」に対するトリガー速度の 2 乗の比で合計の距離を乗じることで補正されます。「補正距

離の開始速度」は選択された値、または最も近い 10km/h（10mph）の単位に設定できます。これは、[Test Set-

up] ページの[Options] 画面で設定します。

 File time – スキャンされたファイルが記録された時刻です。

 Trigger speed – トリガーが入力された速度を示します。

 Save run – このチャンネルを選択すると、各ランの終わりにディスクのアイコンが表示されます。Report 

Generator 画面の各ランを (.vbo) ファイルとしてセーブできます。

 Include box – 各ランに対するチェックボックスが画面に表示されます。これにより、必要なランを選択したり、ま

たは除外して列の 平均を求めることができます。また、この結果をセーブできます。

 Graph run – 各ランの終わりに、グラフのアイコンが表示されます。この アイコンをクリックすると、グラフ画面が

自動的に開き、このランが表示されます。

 Average Longitudinal Acceleration（平均前後方向加速度）– この列には、下の数式で計算された平均前後方

向加速度が表示されます。

o a = (v2 –u2)/2s

o a は加速度、v は最終速度、u は初期速度、および s は移動距離です。

 Vmax – ランの最高速度を表示します。

 Centre Line Deviation – 指定のセンターラインからの車両ズレのデータチャンネルです。センターラインは、画

面上部の [Tools] → [Centre line deviation setup] で設定します。

 User Text – ユーザーは、結果の表にテキストを挿入できます。オートセーブのファイル名に利用することがで

きます。

 Relative Height – 相対的高さは、垂直速度チャンネル（利用可能な場合）から計算されます。これはラン開始を

0 として、相対関係（変化）を示します。短いテストでは、これは標高さチャンネルよりも正確です。

 File Name, Serial Number, File Date – これらの詳細データを結果の表に取り込むことができます。

 Time Since Midnight – [Maths Channels] 画面や Memory Stores を使い、この時間を簡単に利用できます。特

に、ブレーキ停止距離などで停止時間を計算するのに便利です。

 Test Name – 結果の表を作成するのに使用される (.rcf) ファイルの名前を挿入します。これは、他のソフトウェ

アに結果をエクスポートして分析する場合や、Batch Test 機能を使い同一ファイルで複数の種類のテストを実

施する場合に特に便利です。

 Radius Of Turn – GPS データから計算された旋回半径を表示します。旋回半径セットアップツールで選択した

オプションは RepGen にも適用されます。

 Maths Channels – ユーザーが定義した演算チャンネルを列のヘッダーとして入力できます。
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テスト条件を定義する
次にテスト条件を定義します。ここでは、 テスト内容の開始および終了の条件を定義します。レポートデータの表示も選

択できます。例えば、一定の速度、距離、時間に対して、レポートの行を追加するかどうかなどです。

下の項でテストセットアップの詳細について説明します。

Start Conditions
ここでテスト開始条件を定義します。 開始条件のオプションは次のとお

りです。

 Speed 速度がユーザー定義のしきい値を満たした場合にテ

ストが開始されます。

 Brake trigger activated ブレーキトリガーが ON になるとテスト

が開始されます。（速度範囲の選択が可能）

 Cross start / finish line スタート/フィニッシュラインを通過す

るとテストが開始されます。

 Immediately ファイルの開始から、または終了条件の直後にテ

ストが開始さてます。

 Maths channel 1 算術チャンネルの値がしきい値を満たすとテ

ストが開始されます。

上記の条件を OR 条件で組み合わせることができます。つまり、

[Speed]、[Brake trigger activated]、および [Cross start/finish line] オ

プションをすべて有効にした場合、上記いずれか 1 つの条件が満たさ

れると テストが開始されます 。各トリガーパラメータの左にあるチェッ

クボックスでオン、オフを設定します。ボックスにチェックを入れると、そ

の パラメータがテストのトリガーに使われます。

速度条件には以下の 3 つのフィルタオプションも利用できます。

 Increasing しきい値を超えたら開始

 Decreasing しきい値を下回ったら開始

 Either 上記どちらを満たしても開始

これらのオプションは、速度との AND 条件で利用できます。例えば [increasing] オプションがオンになっていると、テスト

はトリガー速度のしきい値を超えると開始されます。

開始条件が満たされた際にコンピュータがビープ音を鳴らす機能もあります。

[Speed >=] フィルター

このフィルタ機能を使い、設定速度を超えないランを除外できます。これはテストの合間の小さな移動を除外するのに便

利です。

Brake Trigger Activated
[Brake Trigger Activated] オプションでは、ブレーキトリガーが入力されたと同時にテストを開始します。また、速度範囲

がゼロ以外の値に設定されている場合、速度の指定範囲内でトリガーが入力されなければテストは開始されません。こ

のフィルタ機能により、Report Generator は、ユーザーが指定した速度の範囲以外のトリガー入力を無視できます。 速

度範囲の上限・下限にゼロの値を入れた場合には、速度に関係なくトリガーが入力されたときにテストは開始します。

演算チャンネル開始条件
演算チャンネルのしきい値開始条件を使ってテストを開始することもできます。より大きい (>) およびより小さい (<) オプ

ションでテスト開始の条件を指定します。これらのオプションのいずれかをオンにするには、チェックボックスをクリックし、

右のボックスにしきい値を入力します。演算チャンネルについては、本マニュアルの「演算チャンネル」の章を参照してく
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ださい。このオプションで、演算チャンネルを任意の測定チャンネル（車両

CAN やアナログ入力）に設定することで、測定チャンネルをテスト開始条

件にできます。

End Conditions
テスト終了条件の設定は開始条件と同様です。ここではテストの終了条件

を定義します。7 つの選択肢からテスト終了を設定します。テスト終了条件

はすべて OR 条件で組み合わされます。従ってテスト中に条件のいずれ
か 1 つが満たされると、テストは終了します。開始条件と同様、速度が増

加、減少またはそのどちらかを選択するフィルタを利用できます。

”End of acceleration” 条件を選択すると、前後方向加速度が 1 秒間 -0.1 

G を下回るとテストが終了します。この計算では、前後方向加速度は自動

的にスムージングされます。この機能では、加速ランのようなテストで車両

の最終速度を事前に知らなくとも分析できます。

Line Conditions
通常、テスト開始および終了条件が満たされると、テスト毎に 1 行ずつ結果が

加えられます。ライン条件を使うことで、開始イベントと終了イベントの間に役立

つデータ行を追加させることができます。

下の表に示したように、さまざまな条件を設定し、テストレポートへ行を追加でき

ます。

演算チャンネルのしきい値の条件を使ってテスト行を追加することもできます。

演算チャンネルにテスト行を追加するには、目的の演算チャンネル条件をオン

にし、対応するボックスにしきい値を入力します。その後、[Maths Channel] 画

面でチャンネルを定義します。演算チャンネルについては、本マニュアルの「演

算チャンネル」の項を参照してください。

演算チャンネルのライン条件の [Allow Reset] オプションを使い、条件が

無効から有効に変わるたびに毎回、新しいラインを追加できます。この

オプションをオンにしなかった場合、結果ラインが追加されるのはテストが開始

されてから初めて条件が有効になったときのみです。

条件 オンにした場合の動作

Speed line ユーザー定義の速度ごと（例：10 Km/h ごと） に 1 行追加されま

す。

Distance line ユーザー定義の距離ごと（例：10 m ごと） に 1 行追加されます。

Time line ユーザー定義の時間ごと（例：0.2s ごと） に 1 行追加されます。

Brake trigger event line ブレーキトリガー入力時に 1 行追加されます。

Start/finish line スタート／フィニッシュラインを通過した際に 1 行追加されます。

Finish line フィニッシュラインを通過した際に 1 行追加されます。

Split line スプリットラインを通過した際に 1 行追加されます。
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Options

[Options] タブにはテストセットアップ設定オプションがあります。

Comments Section Size
このオプションで、テストデータの初めに設けられるテストコメント用エリ

アのサイズを設定します。

Acceleration Units
このオプションで、加速の単位を G、m/s2、または ft/s2 から選択します。

Time Format
このオプションで、時間を秒のみ（ss.ss）で表示するか、または分と秒

（mm:ss.ss）で表示するか選択します。

Autosave Data
このオプションを選択すると、表示されたレポートデータは新しいファイル

に自動セーブされます。

New File for Each Test
このオプションでテストごとに新しいファイルを作成するかどうか、または

全テストを同じファイルでセーブするかどうか指定できます。

Row Count
このオプションで [Report Generator] 画面の最大ライン数を増やすこと

ができます。最大ライン数を少なくすると一部の操作（データのリセットなど）時間が短縮されます。

Continuous Testing
このオプション を選択すると、最初のラン終了後にさらにランのスキャンを継続できます。

Hide Start Condition Line
この機能は、開始条件ラインをレポートから削除します。各ラインが終了結果のみのレポートを作成するときに便利です。

例えばブレーキ停止を複数回行い、列の平均機能を使って平均停止距離を算出する場合などです。この機能は通常、

[Don't leave a line between tests] オプション、および列タイトルの 1 つにある [include box] と組み合わせて使います。

Hide End Condition Line
この機能は、終了条件ラインをレポートから削除します。ランの最中に速度が指定値を超えた場合に限って終了条件ラ

インを削除するように設定することもできます。

Hide Line Condition Line
この機能は、ライン条件の結果をレポートから削除します。この機能は、テストの実行に必要であって、結果の表に必要

ではないラインを削除するのに便利です。

Don’t Leave a Line Between Tests
終了条件を満たすたびに作成される空白の行を入れないようにします。

Hide Test Resets On Over/Under Speed
このオプションをオンにすると、Report Generator は開始条件に合致しているが終了条件に合致していないデータを表

示しません。例えば開始速度を超えた後、加速ランの準備中に開始速度より低くなった場合などです。

これは有効なランの合間の不要データをなくすために非常に役立ちます。

Generate Lines Only During Brake Trigger
このボックスにチェックを入れると、Report Generator はブレーキトリガーが有効な場合にのみデータ行を表示します。

開始条件と終了条件には [Brake trigger] に設定します。

このモードでは、開始条件はブレーキトリガーが有効になると発生し、終了条件はブレーキトリガーが解除されると満た

されます。
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MFDD Settings
MFDD（平均飽和減速度） はこのオプションで設定します。MFDD は、設定されている値に応じて、開始速度のパーセン

ト値または正確な速度から計算できます。

Corrected Distance
このオプションでは、補正距離を指定速度または最も近い 10km/h 値から計算できます。

ブレーキトリガーを取り付けて行う試験の場合、補正の対象となるのはブレーキトリガーが入力されたポイントから車両

が 0km/h に達するまでの距離です。この指定速度または最も近い 10km/h 単位の速度に対するトリガー速度の 2 乗

の比を合計距離に乗じて補正されます。

補正距離は、複数のブレーキ停止距離テストで、トリガー入力されたポイントから停止までの距離の比較に使われます。

人為的なミスによって毎回違った速度でブレーキペダルを押すという問題を修正するため、補正距離はデータを既知の

速度に修正して、正確なデータ比較が可能です。

Accel Smoothing Level
横方向および前後方向加速度計算におけるスムージングの量を調整できます。

経験に基づき、20Hz データではレベル 2、100Hz データではレベル 12 を推奨します。
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オリジナルのプリセットテスト設定を作成する
Report Generator を使用していくと、列タイトルを特定のテスト向けに変更する必要が生じることでしょう。本ソフトウェア

では、オリジナルのプリセットテスト設定を設定ファイルの 1 つとしてセーブできます。例えば、加速テストの設定を修正

し目的の列タイトルを追加修正した後、 [Report Generator] → [Default Test 4] → [Assign Current Test Settings] を選

択し、ファイル名と保存先を選択し、 [Save] ボタンをクリックします。これで、ツールバーの加速テストのアイコンは保存

したファイル名と同じ名前になります。

[Report Generator]ドロップダウンリストの [Assign icon] オプションを使い、登録されている 5 つのプリセットテスト設定

のアイコンの 1 つを必要に応じてそのテストに割り当てることができます。

下のスクリーンショットでは、最初のプリセットテストが デフォルトに設定されています。

登録されているプリセットテスト設定を元に戻すには、ドロップダウンリストの [Return to default] オプションを選択します。

Report Generator のすべての設定をロード＆セーブする
ウィンドウの一番上のツールバーにある [Config]ボタンで Report Generator のすべての設定をセーブ＆ロードできます。

Report Generator 設定の変更時の警告

セーブ前の Report Generator の設定を変更しようとすると、ソフトウェアは

確認画面を表示します。変更前の既存の Report Generator の設定を保存

するかどうかをユーザーに知らせます。

Pick Test
[Pick Test] をクリックすると、以前にセーブした

Report Generator 設定の一覧が表示されたウィンド

ウが現れます。 PC の 特定のディレクトリに設定でき

るので、その中に Report Generator 設定ファイルを

保存しておくと便利です。[Report Generator Pick 

Test] ウィンドウで [Select Directory] をクリックすると、

表示するディレクトリを変更できます。目的のフォルダ

を選択し、 [Enter] キーを押して [Report Generator 

Pick Test] ウィンドウで開きます。

以上の手順により、Report Generator 設定を一覧か

らすばやく選択できるようになります。
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スタート／フィニッシュラインとスプリット

[Report Generator] 画面のツールバーからスプリットファイル

をソフトウェアにロード、または Report Generator に設定され

ているスプリットをクリアできます。

ここでロードしたスプリットファイルは、新しく.vbo ファイルをロ

ードしても設定が消えません。この機能によりユーザー

は.vbo ファイルのみを Report Generator にロードして、すぐにファイルのスキャンができます。

バッチ処理
バッチ処理には Multi-File Test と Multi-Part Test の 2 つのタイプがあります。

Multi-File Test
[Report Generator] 画面で、複数の.vbo ファイルを同時に処理

できます。この処理を行うには、.vbo ファイルをロードする以前に

テスト条件等の Report Generator の設定を行います。 Report  

Generator を目的に従い設定した後、[Report Generator]オプションの[Load Into RepGen] ＞[Multiple Files]をクリックし

ます。必要な.vbo ファイルを複数選択すると、Report Generator は自動的に複数の.vbo ファイルを一括処理します。

注：処理対象.vbo ファイルは単一のディレクトリに保管されている必要があります。

Multi-Part Test
Multi-Part Test では、様々な種類のテストを順番通りに実施で

きます。この機能は、様々なテストを 1 つの.vbo ファイルから実

施する場合や、 装置の校正ランを実施して校正結果をレポート

に取り込む場合に便利です。

Multi-Part Test のセットアップファイルは、多様な設定オプション

に加えて、画面のレイアウトも保持しています。そのため、Report 

Generator は表示する パラメータ、 パラメータのフォーマット、パ

ラメータの表示位置を自由に設定でき、テスト結果を明瞭に表示

します。

Multi-Part Test を設定するには、[Multi-Part Test ] ＞[Add 

Test ] から既存の Report Generator 設定ファイルを複数選択し、

それらのファイルを希望の順に配置します。これらの.rcf ファイル

には、あらゆるテスト設定、例えば開始、終了、およびライン条件、

列タイトル、列タイトルの位置が含まれます。

次に Multi-Part Test の構成を .btf（“Batch Test File”）フォーマ

ットにセーブする必要があります。

Multi-Part Test が設定され、セーブされると、 [Run Multi-part Test] ボタンを選択するとファイルの処理が開始されま

す。

Speed Columns
テスト条件オプションの Speed Columns を使用すると、1 つのランの計測時間を縦ではなく横に並べて（行と列を入れ替

えて）、画面に表示できます。Speed Columns の使用例は下表を参照してください。

加速度の例

4 つの 0-60km/h ランを行い、10km/h 間隔の加速時間を表示しました。

Run num 0-10 0-20 0-30 0-40 0-50 0-60

1 0.39 0.71 1.02 1.48 1.83 2.2

2 0.48 0.8 1.15 1.45 1.74 2.13

3 0.47 0.81 1.16 1.49 1.81 2.15

4 0.6 0.99 1.4 1.88 2.88 3.33

Avg=0.49 Avg=0.83 Avg=1.18 Avg=1.57 Avg=2.06 Avg=2.45
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Speed Columns を使用しない場合、結果は毎回、別の行に表示されるので、速度範囲での平均値を出すことはできま

せん。

Run num Speed Time

1 0 0.0

10 0.39

20 0.71

30 1.02

40 1.48

50 1.83

60 2.2

2 0 0

10 0.48

Speed Columns の設定

Speed Columns は Report Generator の [Test Setup] から設定します。

Speed Columns には 2 つのタブページ、1-10 と 11-20 があります。

各 Speed Column は 2 つのイベントの間隔か

ら結果を生成します。この 2 つのイベントはプ

ルダウンリストから選択できます。

各 Speed Column の開始＆終了ポイントは手動で値を入力して設定できま

す。

[Auto Generate] 機能による設定も可能です。

注：1 つの Speed Column を 0-60 テストに設定した場合でも、[Test 

Setup] を使い通常どおり全体のテスト開始条件および終了条件を設定す

る必要があります。例えば、0-100 のテストを 10 個の Speed Columns を

使って行う場合、開始条件を 0 km/h、終了条件を 100 km/h に設定した後、

10 きざみの増分に対して 10 個の Speed Columns を設定します。

Speed Columns の割り当て

Report Generator の結果表示ウィンドウの列タイトルに Speed Columns の 1 つに

割り当てるには、列タイトルのヘッダーをクリックし、プルダウンリストから 1 つを選

択します。

注：Speed Columns の名前がこのリストにない場合は、[Test Setup] の[Use] ボッ

クスにチェックマークが付いているか確認してください。

注：”ハイライト” などの一部の機能は、Speed Columns で使うことができません。
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Memory Stores
メモリストアは、固定の値を保存することのできるメモリ機能です。メモリストアには 10 個のスペースがあり、次の 3 つ

のいずれかの方法でこのメモリストアに値を割り当てることができます。

1. [Tools] → [Memory stores] をクリックします。次に、メモリに残し

たい値を入力して保存します。

2. 記録したいセル上で右クリックして、”Assign value to memory store”を選

択すると、すぐにメモリに割り当てることができます。

3. 任意のパラメーターの列タイトルの上で右クリックして、その値を自動でメモリに割り当てます。

下の例では、”Dist(m)”の 3 行目の値をメモリに割り当てています。
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Memory Store の使用例

例えば、ホイールスリップ測定のため、 ホイール速度エンコーダを取り付けているとします。ホイール速度エンコーダは

1 回転当たりのパルス数を出力しますが、タイヤの直径は変化するので、まずエンコーダ を正確に 校正する必要があ

ります。

1. ホイール速度エンコーダのチャンネルを GPS 速度で割るように演算チャンネルを設定します。

2. [average from start] オプションを選択します。

3. 演算チャンネル カラムのヘッダーを右クリックし、メモリストアに割り当てます。[End of Test] 条件時にそのメモ

リストアが結果を記録するように設定します。

4. ホイールスピンをしていない加速テストをスキャンします。

5. 以上の手順により、テスト終了時、速度エンコーダの校正値を持つメモリが記録されます。

このメモリ（値）をこれ以降のテストの乗数として利用し、ホイール速度エンコーダの出力を校正済みのホイール速度出

力（km/h）に変換できます。

テストラインからの Memory Store

Report Generator の結果の値をメモリストアに割り当てることが可能です。

特定のラインの結果をメモリに割り当てるには、先に説明したように、[Report Generator] 結果表の列タイトルの上で右

クリックをして、 [Assign value to memory store] をクリックします。[Memory store] ダイアログボックスが表示されますの

で、[Test Line] ボックスにチェックを入れ、その下の欄に、割り当てるライン番号を入力します。
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列タイトルとしての Memory Store

10 個のメモリストアから任意の 1 つを選択し、結果の表の列タイトルにできます。これは、メモリストアに記録されている

値を知るのに便利です。

メモリストアを列タイトルとして選択するには、Report Generator の空白の列タイトルの上で左クリックします。有効なチャ

ンネルを表示したドロップダウンメニューが現れるので、目的のメモリストアを探し、それを選択して [OK] をクリックしま

す。

Report Generator の演算チャンネル
[Report Generator] 画面のツールバーには [Maths Channel] アイコンがあり、これを使い最大で

5 つの演算チャンネルを作成し Report Generator で利用できます。数式の結果、および Report 

Generator が作成した情報を表示するのに加えて、これらの演算チャンネルは Report Generator

のテスト開始条件やライン条件として利用できます。

詳細は「Report Generator 画面で RepGen 計算式チャンネルを作成する」の項を参照してください。
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VBOXTools Software – 演算チャンネル

The VBOXTools ソフトウェアには、VBOX データチャンネル、数字、および計算関数の組み合わせにより数式を作成す

る機能があります。

この機能の一例に、道路勾配の計算があります。垂直方向速度チャンネルを取り込み、それを水平速度チャンネルで割

ってから 100 倍し、道路勾配をパーセントで表します。

VBOXTools ソフトウェアの演算チャンネル機能には 2 種類あります。

 新しい演算チャンネルを追加する機能

－ グラフ画面で、ツールバーの [新しいチャンネルの作成] ボタンを選択して演算チャンネル機能にアクセスし

ます。

新しい演算チャンネルでは、記録した VBOX ファイルのパラメーターから、任意の数の新しいチャンネルを作成できます。

その際には、CAN チャンネルと演算チャンネルの合計が 32 を超えてはいけません。

 Report Generator で利用する計算式チャンネルを作成する機能

－ [Report Generator] 画面で、[Report Generator] ツールバーの [ 計算式チャンネル] ボタンを選択して

RepGen 計算式チャンネル機能にアクセスします。

RepGen 計算式チャンネルでは、 5 つのチャンネルの作成が可能であり、それらをライブデータや後処理データで利用

できます。作成されたチャンネルには、Maths 1 － Maths 5 の名前が与えられます。

演算チャンネルの基本
[ RepGen 計算式チャンネル]、または [ 新しいチャンネルの

作成] を選択すると、数式を入力する新しいウィンドウが表示

されます。

ウィンドウには、記録したチャンネルやライブチャンネルのリ

ストが表示されます。

[ 式] ボックスで数式を入力します。

リストのチャンネルをクリックし、数式に追加します。

[ 式] ボックスでは基本計算関数を利用できます。 基本計算

関数の記号は下記のとおりです。

 + – 加算

 –   – 減算

 *   – 乗算

 /   – 除算

 ( ) – 開き括弧、閉じ括弧

より複雑な計算関数を [ 式] ボックスに入力したい場合は、[Maths Functions] ドロップダウンメニュー

から選択することも可能です。
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グラフ画面に新しい演算チャンネルを作成する
記録された VBOX データから勾配チャンネルを作成する例を以

下に示します。勾配を求めるには、垂直方向速度（km/h）を水平

速度（km/h）で割り、その値を 100 倍します。

ステップ 1：ファイルをロードする

[Load All]  アイコンをクリックして.vbo ファイルをロードします。

[グラフ] アイコンをクリックしてグラフ画面を開くと、ロードしたファイルが時系列データで表示されます。

ステップ 2：新しいチャンネルウィンドウを開く
ツールバーから [ 新しいチャンネルの追加 ] アイコンをクリックします。新しいウィンドウが開き、ロードしたファイルから

利用可能なチャンネルのリストが表示されます。

ステップ 3：数式を作成する
[Vertical Velocity] チャンネルをクリックすると、そのチャンネルに関連する頭文字が [ 式] ボックスに表示されます。除

算記号 ”/” を入力し、[Speed] チャンネルをクリックして [ 式] ボックスに表示させます。次に “*100” と入力します。

ステップ 4：数式を計算する

ウィンドウの上段の [Generate Channel] アイコンをクリックします。ボックスが現れ、最初のサンプル

ポイントでのデータに対する計算の例が表示されます。確認ができましたら、OK をクリックして次に進

みます。 次に [Channel Name] ボックスが表示されるので、チャンネル名を入力します。この例で

は、”Gradient (勾配)” です。

[OK] をクリックすると、[Channel Units (単位の入力)] ボックスが表示されま

す。この例では、”%” を使用します。[OK] をクリックすると、チャンネルリスト

に新しいチャンネルが表示されます。

ステップ 5： 新しい演算チャンネルを表示する
これで新しい演算チャンネルが作成されました。そのチャンネル

は利用可能なチャンネルリストに表示され、 他の標準チャンネ

ルと同様にグラフ画面に表示できます。

ステップ 6：新しいチャンネルをセーブする
ツールバーの[Save] をクリックし、新しい演算チャンネルが含ま

れるデータを新しいファイルとしてセーブします。その結果、新し

い.vbo ファイルに演算チャンネルが含まれます。
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Report Generator 画面で RepGen 計算

式チャンネルを作成する
この例では、 車両 CAN 車輪速チャンネルと GPS 速度チャ

ンネルとの差を割り出し、ホイールスリップを示す演算チャンネ

ルの作成手順を例に説明します。

RepGen 計算式チャンネルは、Report Generator で利用するだ

けではなく、ライブウィンドウに表示することもできます。

ステップ 1：オンラインモードで VBOX を PC

に接続する
VBOX に電源を入れ、PC と接続します。次に VBOX をテスト車

両の CAN -Bus に接続し、適切な CAN の設定を行い、VBOX

で車輪速を測定可能にします。CAN チャンネルを有効にする手

段は、 「VBOX とモジュールの環境設定」の項を参照してくださ

い。

ステップ 2：Rep Gen 演算チャンネルを実行

する
ツールバーの[Report Generator] をクリックし、[ 計算式チャン

ネル] を選択して、計算式チャンネル機能を起動します。新しいウィンドウが現れ、接続されている VBOX で有効になっ

ているチャンネルのリストが表示されます。

右上の画面例では、最後の 4 つのチャンネルはテスト車両の 4 つの車輪速チャンネルです。

ステップ 3：数式を作成する
車両ホイールがホイールスリップを起こすパーセントを求める数式は、

(GPS 速度 – 車輪速) /GPS 速度 * 100 です。

チャンネルリストから必要なチャンネルをクリックして数式に追加し、数式を作成します。

数式は以下のようになります。

この例では、数式は [Formula 1] セクション

に作成されています。この場合、数式の計

算結果は[Maths channel 1] に表示されま

す。[Formula 2] ウィンドウでもう 1 つの前

輪のスリップ率のチャンネルを作成します。

ここまで出来たら、[Apply]をクリックして、

[ 計算式チャンネル] 画面を閉じます。

ステップ 4：Report Generator 画面の環境を設定する
これで RepGen 計算式チャンネルが設定されたので、[Report Generator] 画面で計算式チャンネルの列タイトルを追加

します。この例のテストは、トリガーを利用したブレーキ停止距離テストなので、プリセットテスト設定で [トリガーテスト]

を選択しています。また、[Maths  channel 1] および [Maths channel 2] という列タイトルが追加されています。
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[Test Set-up] 画面で、どちらかの演算チャンネルが 10% を超えた場合に結果にデータラインが現れるようにライン条件

を設定します。車輪速が車両速度の 90% 未満になった場合でも、データラインが現れます。

以下の画面例を参考にしてください。

ステップ 5： ライブウィンドウで RepGen 計算式チャンネルを表示する
RepGen 計算式チャンネルのライブウィンドウを作成するには、計算式チャンネルの 列タイトルで右クリックし、[View as 

Live Data] オプションを選択します。以下の例では、新しいライブウィンドウに 2 つの前輪のスリップ率（%）がリアルタイ

ムで表示されます。

計算関数とカスタム式
演算チャンネル機能と新チャンネル機能はいずれも、平方根や Cos などの高度な計算関数を活用でき、独自の数式を

セーブして後に使用することもできます。[Maths Channel] 画面にセーブされた数式は [New Channel] 画面で仕様でき

ます。

数式をセーブするには、まず数式を [Expression] テキストボックスに入力します（[Maths Channel] 画面では、任意の

[Expression] テキストボックスから入力できます）。 入力した後、[Save Formula] ボタンをクリックします。すると、数式の

名前を入力するよう求められます。数式をセーブしたくない場合（数式が誤っている場合や別の 数式を [Maths 

Channel] 画面にセーブしたい場合など）、[Cancel] をクリックします。キャンセルしない場合には適切な名前を入力し

[OK] をクリックします。

セーブした数式を再び使用するには、 [Maths Functions] アイコンをクリックし、[User Defined] カテゴリから必要な数式

を選択します。[Maths Functions] アイコンをクリックすると標準計算関数のリストも表示されるので、同じ方法で数式に

標準計算関数を挿入できます。
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Rate of Change (微分)
演算チャンネルは、微分（ROC）関数を活用できます。この関数は、選択されたチャンネルがサンプルごとに変化する割

合を出力します。この機能は、測定データが標準ログレートで計算されていることを前提にしています。ログレートが変

更されていると間違った結果となる可能性がありますのでご注意ください。

微分関数は 1 つのチャンネルで他の計算関数と共に使えないため、注意が必要です。しかし、ROC 機能を使用する演

算チャンネルは、他の演算チャンネルでデータチャンネルとして使用できます。その場合には、次のようなチャンネルの

作成が可能です。

演算チャンネル = （チャンネル A） +（ チャンネル B の 変化率）

以下の 2 つの演算チャンネルを作成して、この演算チャンネルを作成します。

演算チャンネル 1 = （チャンネル B の 変化率）

演算チャンネル 2 =  （チャンネル A） +（ 演算チャンネル 1）

目的のデータは演算チャンネル 2 を利用して表示できます。


